(ITM-VIII 1 COMMUNICATION TECHNOLOGY )

I

11

I1I

v

VI

Fill in the blank

1) WiFi 2) UTP 3) Ring 4) Topology 5) Star
6) Network devices 7) Infrared  8) Sender to receiver

Match the following

1) Exchange of data  2) Wireless Transmission ~ 3) Cable TV

4) Connects multiple computer  5) Single cable 6) Storing and accessing data
True or False

1) True 2) True 3) False 4) False 5) True 6) True
Answer the following

1) A computer network is a group of interconnected computers through cables,
telephone lines, radio waves, satellites or infrared light beams.

2) There are five types of network topologies: Bus topology, Ring topology, Star
topology, Mesh topology and Tree topology.

3) Advantages of computer networks are File Sharing and Remote File Access,
Resource Sharing, Increased Storage Capacity, Sharing a single internet connection
and Security.

4) Ring Topology means each computer is connected to two other computers in the form
of a ring or circular structure. In this topology all data travel in the same direction.

5) Cloud computing is term that refers to storing and accessing the data online so that,
we can access them from any computer in any location. Its two advantages are:
Efficient storage and computing services. Allows for easy connectivity to servers and
information sharing.

6) Bluetooth, Infrared, Radio Wave, Microwave, Communication Satellite, Wi-Fi
Pick the Correct

1) 1994 2) Ring 3) Hub 4) Optical
Identify the Topology
N ,
¥
Star topology




(ITM-VIII 2 MORE ON HTML

I Fill in the blanks
1) SRC 2) HSPACE 3) MARGINHEIGHT 4) Scrollbars 5) FRAMESET
I Answer the following
1) Align=top - Align the text to the left or right top corner of the image.
Align=middle - Align the text to the left or right middle part of the image.
Align=Left - Align the image to the left margin.
2) Frame tag is used to disply more than one web page in the same browser window -
even wepages from other web sites.
3) Marginheight - This attribute specifies the top and bottom margins of the content of
the frame in pixels.
Marginwidth - This attribute specifies the width between the content of the left and
right sides of the frame in pixels.
Scrolling - This attribute specifies the window can have scrollbars or not, by setting
the values as Yes, No, Auto.
(mm-vin | 3 INTRODUCTION TO MS ACCESS )
I Fill in the blanks
1) Data 2) Database 3) ab.accdb 4) Records 5) Fields
6) Tablel 7) Id 8) Primary key 9) Short text ~ 10) Design
I Write the example for Data types
1) Address  2) Phone number 3) Rupees 4) DOB
I State True or False
1) True 2)False 3)True 4)True 5)False 6)True 7)False 8)True
v Multiple choice question
1) RDBMS 2) Design View 3) 255 4) Long Text 5) Save Time
\4 Match the following

1) Create a new record 2) Save record 3) Delete record

4) Descending order 5) Datasheet View



VI Fill the Crossword
1) Tables 2) Fields 3) Reports 4) Query
VII  Answer the following
1) A database is an organized collection of related data so that it can be easily accessed,
managed and updated. MS Access, Oracle and SQL.
2) A primary key is a field or combination of fields that uniquely identifies the records
in a table.
3) Select any record that needs to be deleted then click on drop down arrow of Delete
option in te record group in Home tab. Select Delete Record.
4) Short Text, Long Text, Number, Currency, Date/Time, Auto Number, Yes/No,
Hyperlink, Memo.
Long Text: This data type allows to store lengthy texts, that is up to 65536 characters.
Hyperlink: Text and numbers stored as text and used as a hyperlink address.
5) A record consists fields
Data organized in columns of a table is called Fields
6) Save Time, Save Money, Avoid Data Redundancy, Data Security
VIII Write one word questions about Data Type
1) Memo  2) Primary Key 3) Yes/No  4) Short Text 5) Currency  6) Number
IX Find out the following
1)5 2)3 3) OrderList. accdb 4) Currency 5) Datasheet view
X Identify the following
1) Object Tab 2) Field Grid Pane 3) 255 4) Field Properties Pane
1) Primary Key 2) Tools Group
(om-vin | 4 MORE ON MS ACCESS )
I Fill in the blanks
1) Or 2) Layout 3) Show 4) A query 5) Sort 6) Form
7) Header/ Footer 8) Queries
IT Match the following
1) Report View 2) Print View 3) Layout View 4) Design View
5) Show Table 6) Run 7) Report 8) Form
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State True or False

1) False 2) True 3) True 4) True 5) False 6) False
Identify the following

1) Field List pane  2) Report  3) Design grid 4) Print Preview  5) Run

Mark the following part of the Query windows

Hi#

Answer the following
1) A form is a database object that you can use to enter, edit, or display data from table

These are three view: Form View, Layout View, Design View.

2) A report is a database object that is used to organize and display data pulled from
table or queries. Report is an effective way to organize and summarize data for viewing
or printing.

3) Click the down arrow under View option in the View group on the Home tab or

the Design tab.

Click on the Print Preview tab. The report is displayed in the manner in which It would
appear on a page.

Choose appropriate values for Page Size, Margin and Orientation from the Ribbon.
Click on the Print command to print the report, then click Close Print Preview.

4) Query window is divided into two panes. Top and Bottom. Bottom pane displays

a design grid where you can add field to query and also specify the criteria.

5) Report View, Print Preview, Layout View, Design View

6) To create a Form, select a table in the Navigation Pane that you want to use as the

data source for the form and follow the steps given below:



Click the Create tab on the ribbon. Select the Form in the Forms group. A form is
created and it opens in the Layout View. There are three new tabs: Design, Arrange and

Format appear in the Ribbon and then save the Form.

(ITM-VIII 5 CHART WITH REPORT )

I

Fill in the blanks
1)Chart 2)Create 3)Legend 4)Layout 5)Control 6)Ribbon 7)External data 8)Outline

I Match the following

1) Controls  2) Report Wizard 3) Landscape 4) External Data  5) Blank Report
I Write the name of Group/Tab

1) Export 2) Create 3) Controls  4) Report Wizard 5) Reports
v State True or False

1) False 2) False 3) True’ 4) False 5) True
\% Answer the following

1) A chart is a graphical representation of data. There are two basic part of a body:

body and legend.

2) To modify group/ sort in an existing report, to select a particular field for grouping

click the arrow for change the order then select any field for sort click it in the

ascending or descending order.

3) There are three layout in a report. 1) Stepped, 2) Block, 3) Outline

4) Open the table Office _Address _ List and click on the Word tool on Export Group in

External Data tab.

The Export- RTF file dialog box appears on the screen. Click OK.

Select the location to save and type the Word file name in textbox. Click Close.
(Tm-vin | 6 INTRODUCTION TO VISUAL BASIC )
I Fill in the blanks

1) Visual Basic 2) Graphical User Interface 3) Solution Explorer

4) Properties 5) Back Color 6) Button 7) Variable  8) Arrays



IT Choose the correct answer
1) Statements 2) Methods 3) Forms 4) Data Types
5) Variable 6) Ctrl + Shift +S 7) Function
I State True or False
1) False 2)False 3)False 4)False 5)False 6)True 7) False 8) True
v Answer the following
1) Variable is a temporary storage space for numbers, text and objects. Visual Basic uses
Variables constant and data types for storing values and data.
2) Forms are the foundation for creating the interface of an application. It is used to add
window form and dialog boxes to your application.
3) Statement :- A statement or commands is an instruction that performs an
action. For example command BEEP produces a sound through a computer speaker,
PRINT displays something on the screen.
Methods :-

By methods, it means the action an object can perform. For example, we can
make the form invisible on the screen by making visible method forms as false.
Functions :-

Functions are instructions that return a value. For example NOW () is a
function which returns the current date and time.

4) Event is a most of windows software work by responding to the user action. For
example, when you press a key on a word processor, then a character appears in the
document. Here the event, pressing a key is followed by a response, change in the
content of the document. This process of responding to an event is vital for creating
visual Basic application.

5) Text : Name of the form which appears in the title bar of the form.
Back Color Determine the background color of the form.

Form Border style :  Determine border style of the form.



6) Data types control the internal storage of data in Visual Basic. By default, Visual
Basic uses the variant data type. There are a number of other data types, which allow
you to optimize your code for speed and size when you don’t need the flexibility that
variant provides.

7) Variable declared with the Dim statements within a procedure exist only as long

as the procedure is executed. When the procedure finishes, the value of the variable
disappears. In addition, the value of a variable in the procedure is local to that procedure
That is, you can’t access a variable in one procedure from another procedure. These
characteristics allow you to use the same variable names in different procedure without
worrying about conflict or accidental changes. Example : Dim a as integer

8) Click on Save all button on the standard toolbar, the save project window will be
displayed. Then click on Browse button, Now a project location window will be
displayed. Here we can specify the location of your project. After selecting project
location, click on the Save button.

9) Solution explorer window lists the forms and modules in your current project. A
project is a collection of files which are used to build an application. To access solution
explorer, select solution explorer on the view menu. You can open project items for

modification and perform other management tasks directly from this view.

(ITM-VIII 7 VB CONTROLS AND PROPERTIES )
Fill in the blanks
1) Close 2) Show 3) Image 4) Multiline 5) Radio Button

6) Msg Box(prompt[,buttons][,title][,helpfile,context]) 7) Picture Box 8) List box

Name the following

1) Combo box 2) Check box 3) Radio button 4) List box
State True or False
1) True 2) False 3) True 4) False 5) True

Choose the correct answer
1) Close 2) Radio button 3) MsgBox 4) Text 5)Check box 6) Radio button



Answer the following
1) Label : Labels are used to display text that user does not need to edit.
Text box: Text box is an essential part of Visual basic application.
Difference between Labels and Textboxes are as follows:
Label : You can still change the text displayed your label, by setting the text property.
You can change what is displayed as a label.
Text box: You can type into a text box at run time.
Text box can display a large amount of text which the user can scroll through.
2) Check boxes : Checkbox is a small box with a caption.
Picture box: Picture box is a box which contains a picture.
List box: A scrollable list of choices from which the user can choose.
3) Events : An event is a message sent by an object announcing that something has
happened. For example : click it is a commonly used event.
Private Sub Buttonl lick( By Val sender As object, By Val e As System. Events
Args) Handles Button 1. Click
Picture Box1.Image = Image. From File ( “ D:/ pictures/ rain. jpg”)
End Sub
4) Methods are used to manage a form in VB
Show :It displays form on the screen. This method displays a form modally or
mode lessly.
Form 2 .show
Hide : Hide a form the screen. The user can’t access a hidden form’s controls.
Form. Hide or Me. Hide
Close : Close statements is used to remove a form from the memory. You can
exist a program this method.

Me. Close or Form1.Hide



5) Click on the picture box icon in the tool box and place on a form. Then click the
small button to the right of the Image property. Then Select Resource dialogue box
will be appeared. Click on Import button and Navigate to a picture file and click on
Open button. Then click on OK button in Select Resource Window.
6) The radio button is also referred as Option button. It is used when the user is
expected to select only one from the given options.
7) InputBox ( Prompt[,title][,default][,Xpos][,helpfile,context])
8) MsgBox() is used to display messages or warnings to the users. You can also get
a return value corresponding to one of the buttons in the message box.

Syntax : MsgBox(prompt[,buttons][,title][,helpfile,context])
9) Checkbox is a small box with a caption. When user clicks the box, a check mark
appears. Another click removes the check mark. Checkbox allows the user to select
one more options from a set.
10) Checkbox:- It is a small box with a caption. When user clicks the box, a check mark
appears. Another click removes the check removes the check mark. Checkbox allows
the user to select one or more option The radio button is also referred as Option button.

It is used when the user is expected to select only one from the given option.

(ITM-VIII 8 ADOBE PHOTOSHOP )

| Fill in the blanks
1) Thomas and John Knoll  2) Tools panel 3) Panels  4) Resolution
5) Warping  6) Eye 7) Marquee 8) Shift + Ctrl+ N
9) Color Replacement 10) Sponge
1T Identify the following tools
1) Create New folder 2) Magnify tool 3) Magic want tool  4) Pen tool
5) Crop tool 6) Art History Brush 7) Colour Replacement 8) Brush tool
I Expand the following abbreviations
1) Photoshop Document 2) Joint Photographic Expert Group



3) Graphic Inter Change Format 4) Cyan, Magenta, Yellow, Key (Black)
5) Red, Green, Blue 6) Tagged Image File Format
1A% Choose the correct answer
1) Marquee 2) Type 3) Crop 4) psd 5) Ctrl +D
6) Spot Healing 7) Clone stamp 8) Magnify  9) E 10) Linear
\% State whether True or False
1) False 2) True 3) False 4) True 5) True 6) True
VI Crossword for the following tools
Across :- 1) Lasso 2) Pen 3) Brush 4) Magic Wand
Down:- 1) Dodge 2) Layers 3) Crop 4) Move
VII  Look at the picture given here and answer the questions that follow
1) Lasso tool  2) Eraser tool 3) Color Replacement tool 4) Layer
VIII Answer the following
1) A user- friendly interface, Advanced image adjustments, Edit motion based material,
Produce multiple or complex images, Create graphics with reduced file size.
2) Marquee Tool, Lasso Tool, Move tool, Quick Selection Tool
3) It provides options related to the tool currently selected in the Tools panel.
For example, to choose the thickness of the Brush Tool selected in the Tools panel, we
use the Option bar.
4) Rectangle Marquee Tool, Elliptical Marquee Tool, Single Row Marquee Tool,
Single Column Marquee Tool.
5) Smudge Tool:- This tool is used to smear the paint on the canvas. It gives an effect
finger painting.
Dodge Tool :- This tool is used to lighten the dark areas of the image.
6) Layers are the transparent sheets that can hold objects and are stacked or moved to
create the image composition. They allow the users to draw, edit, paste and reposition

elements on one layer without disturbing the others.
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